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EXERCISE: TEMPERATURE AND STRAIN MONITORING

Use LabVIEW system design software and the CompactRIO system configured in Scan Mode to interface
with the sensors located in the CompactRIO Demonstration Kit

Goals J

e Use the LabVIEW Signal Processing library to obtain meaningful data from the sensors and display that
information on a user interface

Part A—APPLICATION DESCRIPTION
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>

In this exercise, use LabVIEW and the
CompactRIO system configured in Scan
Mode to acquire data from an RTD and a
strain gauge. Use the Signal Processing
library to filter the strain gauge signal and
obtain the mean of the RTD signal.
Implement a limit-based alarm system for
the RTD signal. Show the results of the
analysis in a user interface.



CompactRIO System

NI Scan Mode

LED Car==5" | STRAIN
== ) GAUGE This feature gives you easy access to
——) rTD signals wired to measurement modules
connected to the FPGA included in the
CompactRIO system.
In this exercise, use the measurement
. modules inserted in slots 2 and 6 of the
> ] CompactRIO system.
R
Inputs Outputs
Slot 6: NI 9219—24-Bit Universal Analog Input (4 Diff, 100 S/s/ch) Slot 2: NI 9401—8 Ch, 5 V//TTL High-Speed
Analog Input 0 (AlI0)>RTD (3-Wire Pt100-TCR3851) Bidirectional Digital I/0 Module
Analog Input 2 (Al2)->Strain Gauge (Quarter Bridge/350 Q) Digital I/0 5 (DIO5)—>LED1
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Part B—CODE IMPLEMENTATION

1. Create an Instance of the Exercise 1: Temperature and Strain Monitoring Sample Project
Launch LabVIEW and create a new LabVIEW project from the Exercise 1: Temperature and Strain Monitoring sample project.

DETAILED INSTRUCTIONS

[ : =) [ . . . .
{8 Create Project e In this exercise, use an existing LabVIEW
Choose a starting point for the project: . . .

sample project as the starting point of the

All = Exercise 1: Temperature and Strain Monitoring  CompactRi0 Demaonstration it -
Templates In this exercise, use LabVIEW and the CampactRIO system configured in Scan Made to acquire i i
Desktop data frarm an RTD and a strain gauge, Use the Signal Processing... More Information a ppllcatlon :
Robaoti
SamSI:PIr:}ects q Exercise 1: Temperature and Strain Monitoring | Solution  CoxpactR!O Demonstration Kit
Inthis exercise, use LabVIEW and the CompactRIO system configured in Scan Made to acquire
C tRIO J 2
Dz::tp:; data fram an RTD and a strain gauge. Use the Signal Pracessing... More Information [ Launch Lab VIEW
MI-579X = Exercise 1: Temperature and Strain Monitoring | C| ge © fa¥s! it . .
Real-Time Madify the block diagram sa the RTD value and the terperature threshald are an the same graph La u nCh La bVI EW by naVIgatl ng to Start »

The line representing the RTD value shauld he

CompactRIO Demanstration Kit cen if the... More Information AII Programs » National Instruments »

CompactRIO Hands On . .
Exercise 2A: FPGA-Based Butterworth Filter Conpact?/O Demaonstration Kit

D trati -
Demeor:;::t‘roanl:ms In this exercise, use LabVIEW ta configure the FPGA chip in the CampactRIO system ta implement |2 Lab VIEW <Year>» Lab VIEW.

v By BF BB B

a Butterwarth filter. More Information
— Exercise 2A: FPGA-Based Butterworth Filter | fon . 10 [0 Kit

In this exercise, use LabVIEW ta configure the FPGA chip in the CampactRIO system ta implement o ge
221 3 Butterworth filter. More Information o Create an Instance Of the EXIStlng
— Exercise 2A: FPGA-Based Butterworth Filter | Chall [= fa}s! tration Kit Lab VIEW Project

Add a graph of the pawer spectrum fram the signal to the Ex-2 Real-Time.vi. More Information

Click on the Create Project button on the
Exercise 2B: LED Array Display  CompactRi0 Demonstration £t . . .
Inthis & use the FPGA portion of the CompactRIO system to interact with the array of LEDs rlght Slde Of the mailn screen Of LavaEW
inthe ratary assembly of the CompactRIO Demonstration Kit. Mere Information . .

and create an instance of the Exercise 1:

£

CHERERT

Exercise 2B: LED Array Display | Soluti i 10 0 tration Kit

Inthis e use the FPGOA portion of the CompactRID system to interact with the array of LEDs H H H

in the rotary assembly of tI:— CompactRID Demonstration Kit. More Information Temperature and Straln Monltorl ng

Exercise 2B: LED Array Display | Challenge  CoiygactRio Demansivation it sample project located at:

Add code to display both the strain gauge signal and the RMS value on the strain gauge chart

More Information

Fyarcica 3 Machina Coandition Manitoring Swst, [ [la¥y! ih F i 57 CompaCtRlO Demonstration Kit>> CompaCtRlo Hands on
Mext ] [ Cancel ] [ Help

Click Next to customize the Project Name and
Project Root if desired. Finally, click Finish to
create the project.
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2. Explore the LabVIEW project.

Explore the project and expand the hierarchy on the project to display all measurement modules and channels to be used

in the exercise.

i3 EX-1 Temperature & Strain Monitoring.] 'v'pmj...li‘ﬂlﬂ_hj

File Edit View Project Operate Tools Window Help

=1 = SR | E- @ o

B Tgﬂ. Project: EX-1 Temperature & Strain Monitoring.lvproj
B ﬂ My Computer
I '::,' Dependencies

4— Build Specifications
E} n CompactRIODemokit {10.2.225, 10 L) =

= - Chassis (cRIO-9065)
=" II Mod2 {Slot 2, MI9401)
- E BLAMEK (DIO3)
- Camera Tngger (DIO6)
- FAR (DIOT)
- LEDD (DI04
. w - LEDL (DIOS)
- W SCLK (DIOL)

CH3

RTD (CH)

Strain Gauge (CH2)

TC{CHL
Q, EX-1 Temperature & Strain Monitoring RT.vi
- "5 Dependencies

'% Build Specifications

ﬁﬁﬁm

L 4

- B SN (DIO0) I
- ®X XLAT (DIO2)
5 D Mods (Slot 6, N19219)
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CompactRIO
System

Measurement
Modules

DETAILED INSTRUCTIONS

e Expand of the Exercise 1: Temperature
and Strain Monitoring sample project
This project contains the CompactRIO
system and measurement modules for
this exercise.

To expand the hierarchy and reveal the
contents of the project, click the “+”
boxes next to each part of the
CompactRIO system and measurement
modules listed.

The inputs and outputs for this exercise
have already been named and are listed
under their corresponding modules.



3. Open the EX-1 Temperature & Strain RT.vi file.
This file contains the user interface and the block diagram with the code that you need to complete the temperature
control exercise.

(A)

@/ ‘

RTD (CHD)
Strain Gauge (CH2)
wan T ((CHTY
i EX-1 Temperature & Strain Monitoring R@

ErEpETTeTE h
% Build Specifications

{3 EX-1 Temperature & Strain Moy

-
& Strain Monitoring [s[E] & -~

~.
~.

File Edit View Project Ope

..
~.

(O[] [ 1speappiication Fam

y‘—qwﬁ N

Temp Threshold  RTD ()

30 30
29 29
28 28
21 27
26 2
25 d 25

L] STOP ]

Strain Gauge

5000

400u-|

300u-|

original Data |\
Filtered Data [/

.,
~.
~.
~.

.
~.
~.
~.

Amplitude

2001

100

fter Para

sal
=

9

[EX-LTemperature & Stiain Monitering

Front Panel
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DETAILED INSTRUCTIONS

Open the EX-1 Temperature & Strain
Monitoring RT.vi File

Double-click on the EX-1 Temperature
& Strain Monitoring RT.vi file located
at the bottom of the LabVIEW Project
Explorer window as shown in Figure A.

Display the Block Diagram

On the menu bar, click on Window »
Show Block Diagram or press <Ctrl-E>
to switch between the front panel and
the block diagram as shown in Figure
B.

Complete the code by inserting the
inputs and outputs from the
measurement modules into the While
Loop labeled Data Acquisition. Using a
Butterworth Filter function and a Mean
function, monitor the RTD and the
Strain Gauge.



4. Add the inputs of the monitoring application to the block diagram.
Place the RTD and Strain Gauge I/O channels onto the block diagram.

DETAILED INSTRUCTIONS
i -~ - . i - — @ B
i3 ex 1 Temperature & Strain Monlmrlng.lvpmj...u_lﬂ ° Add the RTD I/o Node to the BIOCk
File Edit View Project Operate Tools Window Help Diagram
S| ¥ X||E8|E-@ 0| § £X-1 T ture & Strain Monitoring RT.vi Block Diagram o .
_ | | Siininiieiaiisiionidc et o1 From the LabVIEW Project Explorer
Items | Files | le Edit View Project Operate Tools Window Help 3
= |T_=;1, Project: EX-1 Temperature & Strain Menitoring.lvproj o | O@ T @pliceti: WlndOW, drag and drop the Channel
=) Eﬂh#E‘”YDCD"”Pd“tE’_ 0 labeled RTD (CHO) under Mod6 (Sloté6,
ependencies . L.
% Build Specifications = NI 9219) onto the block diagram inside
ity CompactRIODemokit (10.0.0.50) Ctraim Ganael? o oge
E @ Chassis (cRIO-9068) E —|1§°——' LB Stran Gauge) the Data Acquisition loop.
0 Va2 102, 19401 =
'_ﬁ BLANK (DID3) Filter Paramaers
T e Tngser (0109 e Add the Strain Gauge I/0 Node to the
. @ LEDO (DIO4) Block Diagram
- ﬁ LED1 (DIOS) .
B SCLK (DIOL) From the LabVIEW Project Explorer
- %% SIN (DIOO :
& XLA‘T (DISEJ ) 3 window, drag and drop the channel
= ['3"0323(5'“& NI9219) e labeled Strain Gauge (CH2) under Mod
uj_?:n Emp resno
- R = 6 (Slot6, NI 9219) onto the block
. % TC (CHD) - diagram inside the Data Acquisition
- [l EX-1 Temperature & Strain Monitoring RT.vi
.. & Dependencies Ioop'
- "% Build Specifications
-1 Temperature & Strain Monitoring.vproj/CompactRIC
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5. Implement the code for calculating the mean of RTD measurements.

Insert the Mean Point-by-Point.vi function onto the block diagram.

- -
I3 EX-1 Temperature & Strain Monitoring RT.vi Block Diagram on EX-1 Temperature & Strain Monitaring.vproj/CompactRIODemoKit = ===

File Edit View Project Operate Tools Window Help

][] sl [~ [ [ 0[5
11 Functions Q, Search|
»

Pragramming

DATA ACQUISITION LOOP

" o E.’ Strain Gauge |
] G| o =]
Structures Amay  Cluster, Clas..
Y Y "
[ ® D)
Numeric Boolean String -
EN =X )
[ ) RTD (C)
Comparison  Timing  Dialog & Use =]
C 0
[ 1]
File 10 Waveform
M M L4
fo L Stop
- J
Synchronizat.. Graphics & S... Report Gener...
Measurement 1/0 » SN -
N , FRIODemokR « [ T 5
o~
Vision and Motion ,
Mathematics >
Signal Processing >
Data Communication ¥V {x] Signal Processing
Connectivity [ Point By Point
Emp = =0
Control Design & Simulatian [ = :
z | pny ]
spress T
Whm Genera... Wm Concliti.. Wm Measure
Addons [ i
A‘v’ ‘w’ ¥ Wi
Favorites { 1w T i Pyobability & Statistics PtByPt
Leelioiancs ! Sig Generatian Sig Operation  Windows Eillers SP““T
Select a VL. ¥ ¥ - -J--'--ED E =H=f b,
Real-Time ' R ke, Finy P s s
FPGA Interface Y Fiters Spectal  Transforms  Point By Point| L€ Algebra - Fitting
Industrial C it 3 difae ¥ MP =] =] ] [
B | i 5
DSC Madule »
Integ & Diff  Prob & Stat RMS MSE  Momentabo..  Median
Y 2!
= Lef3f3]
= B @ L B
Polynomial  Other Functi,  Mode Histagram ~ Gen. Histogr
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DETAILED INSTRUCTIONS

e Insert the Mean Point-by-Point.vi
Function on the Block Diagram
Place the Mean Point-by-Point.vi inside
the Data Acquisition loop by right-clicking
on the block diagram to open the
Functions Palette.

Navigate to this function by clicking to
Signal Processing » Point by Point » Prob
& Stat » Mean PtByPt.vi.

Point-by-point analysis is a method of
continuous data analysis in which analysis
occurs for each data point, point by point.
In point-by-point analysis, the input-
analysis-output process takes place
continuously in real time.



6. Wire the inputs and outputs of the MeanPtByPt.vi function.
Wire the RTD I/0O terminal to the “x” input terminal of the MeanPtByPt.vi function and wire the output of the MeanPtByPt.vi

function to

(A)

the RTD (°C) indicator.

sCans

|:-nm Strain Gauge t

Filter Parameters

|.-f"_“""“ F:T[uf).

Temp Threshold
[DELE

[

initialize ...................... y

@7.{\:—“— rean
sample length ———MEAN Srrar
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RTD (°C)
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DETAILED INSTRUCTIONS

Wire the RTD 1/0O Terminal to the “x”
Terminal of the Mean PtByPt. vi

Move the cursor over the triangle in the
upper-left corner of the RTD I/0 terminal.
The cursor should become a spool; this
indicates the cursor is in wiring mode. See
Figure A. Click on the terminal and move
the cursor to the “x” input terminal of the
Mean PtByPt.vi and click. A wire now
connects the RTD I/0 terminal to the

Mean PtByPt function.

Wire the Output of the Mean PtByPt.vi to
the RTD (°C) Indicator

Create a wire that connects the Mean
output terminal of the Mean PtByPt.vi
function to the RTD (°C) indicator. The
inputs and outputs should look like

Figure B.



7. Implement a temperature threshold for the system.
Add logic to the code to determine when the temperature is greater than a user-defined threshold.

DETAILED INSTRUCTIONS

e Add the Greater? Function to the Block

tonsomeng RTw Block Disgram on £X-1 Tempersture & Strain Montceng peos CompactRIODemaiGe * 534‘,;'1‘,&‘ Diagram
R — , ‘ — Place the Greater? function on the block
2 [15pt Appcation Font |~ (1o~ e | (&0~ |22y CETT NN

diagram by opening the Functions Palette
and navigating to Comparison » Greater?.

This function helps you implement the
limit-based alarm system. You can now
K10 Q) . compare the current RTD value against a

{Arer) .
e} R o Tabais LR ‘ user-defined limit to fire up an alarm.
‘ 3 T X ‘
\ a Geeater?
Sl e B B B > B
qual! ot Equall Greater? Less? Greater OrE.  Less Or Equal?
S — Equal To0? NctEqual To.. GeeaterThan.. LessThan02  Grester OrE.. Less Or Eque—

N B3 B3 p P P

Max & Min  InRange and.. Not ANemb.. Empty Anmay?  Emgey Sting..,

g i > i B ig

Decimal DvgtT  Hex Digit? Octal Digt? Printadle?  Whae Space?  Lencal Class

=] B>

Companison Foed-Pont
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8. Complete wiring the temperature threshold.
Wire the output terminals of the RTD 1/0O terminal and the Temperature Threshold control to the Greater? Function. Also create an
instance of the LED indicator that illuminates when the RTD I/O output is greater than the temperature threshold.

A)

13 EX-1 Temperature & Strain Munimring.lupmj.‘.@m

F RT.vi Block Diagram on EX-1 Temperature & Strain Monitoring vproj/CompactRIODemokKit *

B Strain Gauge (CH2)
- B TC(CHL)

- [ EX-1 Temperature & Stra
-5 Dependencies

% Build Specifications

in Monitering RT.vi

File Edit View Project Operate Tools Window Help cols Windew Help
=1 1 IELYEREY 5|+ [15pt Application Font |~ |3 || | [0~ B o] Search
Items | Files I
| owascousmonoor ]
= el Project: EX-1 Temperature & Strain Monitoring.lvproj DATA ACQUISITION LOOP e
9 E_‘w)‘ Computer Strain Gauge ki
H Eq‘ DEpeHdEHFI.ES ) 3
#; Build Specifications ),
m CompactRIODemeKit (10.0.0.50)
E- W Chassis (cRIO-0068) "
= 0 Modz2 (Slot 2, NI9401)
- B2 BLANK (DIO3)
S5 Camera Trigger (DIOG)
FAN (DIOT) RTD (°C)
LEDO (DIO4) a7 ¥DEL]
J
#% SCLK (DIOL)
HESIN (DI00)
% XLAT (DI02) S — |
=} Mods (Slot 6, NI19213)
B CH3
RTD (CHO)

lproj/CompactRIODemoKit « T
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DETAILED INSTRUCTIONS

Wire Inputs to the Greater? Function
Wire the output of the RTD 1/0 terminal
to the first input terminal of the Greater?
function by creating a branch from the
wire connecting the RTD I/0 terminal and
the Mean PtByPt.vi. Click on the wire
with the cursor in wiring mode and move
the cursor to the first input terminal of
the Greater? function.

Wire the output of the Temp Threshold
control to the second input terminal of
the Greater? function as shown in
Figure A.

Create an Instance of the LED Indicator
Create an instance of the LED indicator by
dragging and dropping the LED1 (DIO5)
from under Mod 2 (Slot2, NI 9401) in the
LabVIEW Project Explorer into the Data
Acquisition loop as shown in Figure B.

Wire the output of the Greater? function
to the input terminal of the LED1 I/O
terminal.



9. Unbundle the values of the filter parameters cluster.
Unbundle the values of the filter parameters cluster to access the individual frequency values within the cluster.

(A)

3 EX-1 Temperature & Strain Monitoring RTvi Block Diagram on Untitled Project 20.lvproj/CompactRI0DemoKit =S

File Edit View Project Operate Teols Windew Help

[#2]|@[1][@][28]|4a|m |7 [ 15pt Application Font |~ |[5e |[7a~ | [55|[oad]

DATA ACQUISITION LOOP

Strain Gauge

Cluster, Class, & Variant

[ S search | &, customizev

ST

Temp Threshold

o

Untitled Praject 20.vpraj/ CompactRIODemoKit ¢

©

Filter Parameters

e FHEOEl

Unbundle By... | Bundle By N Unbundle Bundle

Cluster Cans... Build Cluster... Index & Bun.. Cluster To Ar.. Array To Clu...
& E=

Call Parent To More Spe... To Mare Gen... Pres,

fo] [

LV Object Co... Get LV Class ... Get LV Class ...

&
2
7
=
5

(9

Vois,
55 ... Get LV Class ...

@
3
=
o

{u]

Variant

[
0
T
'e]

@

[
0
T
'e]

Filter Parameters Samplir

e Frecee
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N91 s Sampling freg

low cutoff freg
high cutoff freq

DETAILED INSTRUCTIONS

Use the Unbundle By Name Function to
Access the Frequency Values

Place an Unbundle By Name function
onto the block diagram by opening the
Functions Palette and navigating to
Cluster, Class, & Variant » UnbundiIe By
Name as shown in Figure A.

Wire the output from the Filter
Parameters control to the input terminal
of the Unbundle By Name function as
shown in Figure B. Drag the bottom
resizing tool on the Unbundle By Name
function down to reveal the three boxes
labeled “Sampling freq” as shown in
Figure B. Select the frequency that each
box represents as shown in Figure C.



10. Implement a Butterworth filter to filter the strain gauge value.
Insert the Butterworth Filter PtByPt.vi onto the block diagram to provide filtering for the strain gauge.

DETAILED INSTRUCTIONS

37am on EX-1 Temperature & Strain Monitoring vproj/CompactRIODemakit * L =) e |
Help = @ e Insert the Butterworth Filter PtByPt.vi
cnonfort + |[$ov [ 2a~ (9~ 52l ol Sesech ALV Onto the Block Diagram
O L. Place the Butterworth Filter PtByPt.vi
5"’"?;;3] ' = onto the block diagram by opening the
? Functions Palette and navigating to
R Signal Processing » Point By Point »
Filters » Butterworth Filter PtByPt.vi.
RTD("C) 4
| | Wire the output of the Strain Gauge I/0
Filters PrigyPt |z

terminal to the first input terminal, or the
QIQ Seuch‘%(uﬂmue'l . .
Butterwerth Fiter PtByPLy “x” terminal, of the Butterworth Filter

1 i & &l E] function.

Chebythev  InvChebyshey  Bliptic

o E G & B B
g# Equi-Ripple LP Equi-Ripple ... Eque-Ripple BP Equi-Ripple BS FIR Win Flter
e D
Median Filter FIR Filter
(o] [oso Lo [

IR Fter BRwithlC.  MCascade BR Cascadef.. Sevitzky Golay

\%
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11. Wire the filter parameters and the strain gauge 1/0 terminal to the Butterworth Filter PtByPt function.
Bundle the raw Strain Gauge Value and the output of the Butterworth Filter PtByPt function together and display on the same graph
on the front panel.

Ao

Ll

Filter Parameters

initialize ............................
filter type ]
] Bt Filtered »
sampling freq: fs ﬁ_‘ errar
high cutoff freq: fh
low cutoff freq: fl
arder
plrasem
y s EEEE RSN AEENEEEEEEAEEEEEEEEE
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DETAILED INSTRUCTIONS

Wire the Outputs of the Unbundle By
Name Function and the Strain Gauge I/0
Terminal to the Butterworth Filter PtByPt
Function

Wire the output of the Strain Gauge I/0
terminal to the first input terminal, or the
“x” terminal, of the Butterworth Filter
function.

Wire the Sampling freq terminal from the
Unbundle By Name function to the
second input terminal of the Butterworth
Filter function.

Wire the low cutoff freq terminal from
the Unbundle By Name function to the
third input terminal of the Butterworth
Filter function.

Finally, wire the high cutoff freq terminal
of the Unbundle By Name function to the
last input terminal of the Butterworth
Filter function.



12. Display the raw strain gauge value and the filtered strain gauge value on the front panel.
Bundle the raw Strain Gauge Value and the output of the Butterworth Filter PtByPt function together and display on the same

graph on the front panel.

(A)

i3 ex1 Temperature & Strain Monitoring RT.vi Block Diagram on EX-1 Temperature & Strain Monitoring.lvproj/CompactRIODemokit * = | B |

File Edit View Project Operate Tools Window Help

E&U OE Lo 5t .+ || 15pt Application Font |+ Himv ”Ev ‘ |@v ”l’dl

+[ Search 3, |§|‘

DATA ACQUISITION LOOP

Strain Gauge

ok e
[oBL 2

EX-1 Temperature & Strain Monitering.vproj/CompactRIODemoKit «
\

Unbundle By... Bund

le

- i
E B
=3

=3

Cluster Cons... Build Cluster... Index &
= o

Call Parent ... To More Spe... To More Gen... Preserve Run...

e st et
(] %

LV Object Co.. GetLV Class.. GetLVClass.. GetlV Class.. GetLV Class..

@/ |

|?!%£‘f'?" e

Strain Gauge

L L

_ E

[

Page 20 of 26

DETAILED INSTRUCTIONS

e Bundle the Raw Strain Gauge Value
and the Filter Stain Gauge Value
Place a Bundle function on the block
diagram by opening the Functions
Palette and navigating to Cluster, Class,
& Variant » Bundle. Wire the output
from the Strain Gauge I/0 terminal to
the first input terminal of the Bundle
function. Wire the output of the
Butterworth Filter PtByPt.vi to the
second input terminal of the Bundle
function as shown in Figure A.

o Display the Strain Gauge Values on the
Same Graph
Wire the output of the Bundle function
to the Strain Gauge cluster indicator to
display the values on the same graph.
The wiring should be similar to the
wiring in Figure B.



13. The completed block diagram should look like the image below.

Be sure to save your work by pressing <Ctrl-S> or clicking File » Save.

sCans

Page 21 of 26

|:-nm Strain Gauge ’

DATA ACQUISITION LOOP

Bundle Strain Gauge

Filter Parameters

Unbundle By Mame

Sampling freg

—

low cutoff freq
high cutoff freg Q

Mean PtByPt.vi

_P.c—p +
MIEARM

B Error

e LEDL],

-

12~




Part C—RUN THE APPLICATION

14. Run the application.

Run the EX-1 Temperature & Strain Monitoring RT.vi by clicking the run arrow to deploy the code to the CompactRIO system.

A)

-
{3 exa Temperature & Strain Monitoring RT.vi Front Panel on EX-1°
File Edit View Project Operate Tools Window Help
'Et‘g OE | 15pt Application Font |+ ||E,;.v ”Tu:v
Temp Threshold RTD (°C) Strain Gauge
30- 30- S00u-——
29- 29-
400u-
28- 28-
L] -
27- 27- g 300u
£
26 26 E_
<t 200u-
25- 25-
® , ,
{3 Deployment Progress l E] | eS|

Deployment Status

Initializing...

Calculating dependencies...

Checking items for conflicts, This operation could take a while...
Preparing items for download. This operation could take a while...

Deployment Progress

Close on successful completion

Cancel
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DETAILED INSTRUCTIONS

e Run the VI
Switch back to the front panel <Ctrl-E> and
run the program by clicking on the arrow
button at the top of the front panel as
shown in Figure A. Save the VI when
prompted.

e Deploy the VI
Running the VI deploys the code through
the Ethernet cable to the real-time
controller of the CompactRIO system as
shown in Figure B. This initializes an
interactive execution of the code in which
the code is executed on the CompactRIO
system while you monitor and control
inputs and outputs from the user interface
on the development machine.



15. Modify the Temp Threshold and Filter Parameters values to interact with the system.
Change the values of the Temp Threshold and Filter Parameters on the front panel to interact with the application.

p
3 e Temperature 8 Strain Monitoring RT.vi on EX-1 Temperature & Strain Monitoring.vpro)/CompactRIC Demokit

File Edit View Project Operate Tools Window Help

Temp Threshold RTD (°C)

30-

STOP ]

Strain Gauge

1.5m-|
1.4m-|
1.3m-|
1.2m-|

Amplitude
=
[
3 3
1 1

900u-|
800u-|
700u-|

600u-|
23986

Original Data [\

Filtered Data

1
25009

Filter Parameters

high cutoff freg low cutoff freg

EX-1 Temperature & Strain Monitoring.vproj/CompactRIODemoKit] «

m

m
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DETAILED INSTRUCTIONS

Change the Value of the Temp Threshold
on the Front Panel

Slide the Temp Threshold control to
change the value of the temperature
threshold for the system.

Change the Values of the Filter
Parameters on the Front Panel

Adjust the values of the different Filter
Parameter values to see how the filtering
of the strain gauge measurement
changes.



16. Stop the application.
Stop the application of the code by pressing the Stop button on the front panel of the EX-1 Temperature & Strain
Monitoring RT.vi.

Part D—CHALLENGE

17. Modify the code to display temperature readings on a graph.
Modify the block diagram so the RTD value and the temperature threshold are on the same graph. The line representing the RTD value should
be green if the value is below the temperature threshold and red if the value is above the temperature threshold.

<END OF EXERCISE 1: TEMPERATURE AND STRAIN MONITORING>

Page 24 of 26



ADDITIONAL RESOURCES

BUILD YOUR OWN EMBEDDED SYSTEM WORKSHOP

In the NI Build Your Own Embedded System hands-on workshop, focus on extending your NI LabVIEW skills into FPGA-based
embedded design using NI reconfigurable 1/0 (RIO) hardware.

Purchase the LabVIEW RIO Evaluation kit through the registration process and attend the workshop to receive the following:

e 90-day evaluation of LabVIEW and the LabVIEW FPGA and LabVIEW Real-Time modules
e Board-level NI RIO evaluation hardware device and daughterboard for easy I/O interfacing

e Introduction to the LabVIEW RIO architecture with a qualified NI instructor
e Hands-on experience building your first FPGA-based RIO embedded system with the evaluation kit

To find an event in your area, visit ni.com/byoes.

LabVIEW RIO EVALUATION KIT

B | abVIEW

Page 25 of 26

Using the evaluation kit, develop an embedded system with the LabVIEW
RIO architecture. LabVIEW system design software helps you program NI
RIO hardware, which includes a real-time processor, FPGA, and 1/0. NI
CompactRIO hardware uses this same architecture for prototyping through
deployment with a flexible array of configuration, expansion, and NI C
Series module 1/0 options.

The kit includes an extended evaluation of the LabVIEW FPGA and
LabVIEW Real-Time modules; an NI RIO evaluation device; a
daughterboard for easy 1/0 interfacing; a step-by-step tutorial; and
numerous fully documented, ready-to-run examples of common
embedded tasks implemented in LabVIEW.

To learn more, visit ni.com/rioeval.


http://www.ni.com/byoes
http://www.ni.com/rioeval

NI LabVIEW Real-Time and NI LabVIEW FPGA RECOMMENDED RESOURCES AND TRAINING OPTIONS

System Installation

and Configuration System Development and Deployment

Embedded Control and Monitoring Certified LabVIEW Embedded

LabVIEW Core 1 § LabVIEW Core 2 §

Using LabVIEW k Systems Developer (CLED)*

Getting Started

ni.com/gettingstarted
NI LabVIEW for CompactRIO Developer’s Guide

ni.com/compactriodevguide

* A CLD or higher is required before attempting the CLED exam
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